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Chapter 1:  Introduction  
 

 

PERCEPTION has an integrated material purchasing and inventory control system that 

accommodates the special needs of purchasing material directly for contracts and 

replenishing supplies of general stock.  PERCEPTION effectively handles real-world 

purchasing problems such as use of foreign funds and federal/state sales taxes.  With 

PERCEPTION you can engineer bills of material requirements and utilize full featured 

purchasing functions including purchase order issues, printing and amending.  The 

system tracks receiving and quality control inspections, manages quantities, cost and 

multiple storage locations to support production pick lists. 

 

PERCEPTION has been developed using a state-of-the-art object-oriented graphical 

programming language and open relational database (Sybase, Oracle or Microsoft).  The 

system operates on Windows-based PC client/server networks (Windows 95, Windows 

98, or Windows/NT) and has features for importing and exporting information from/to 

popular PC software products such as spreadsheets, word processors, and other desk top 

office applications.  These features also support systems integration with a variety of 

financial and accounting software and with popular computer-aided design, engineering 

and manufacturing systems. 

 

This tutorial steps you through the PERCEPTION demonstration of basic functions.  

Following some general information about the system, are the steps to create bills of 

material, requisitions and purchase orders.  Material is then received and a pallet is 

created.  The last step is to issue the material. 
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Using PERCEPTION 

 

When PERCEPTION is executed, the sign on screen is displayed, Figure 1-1, and the 

user is required to enter his/her name and password.  If entered incorrectly, the system 

halts and will proceed no further.  For this tutorial, the User Name is SPAR and the 

password is SQL. 

 

 
 

Figure 1-1:  Sign On Screen 

 

Once the user has successfully signed onto the system, the Main Menu, Figure 1-2, is 

displayed for the user. 
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Main Menu 

 

 
 

Figure 1-2:  Main System Menu 

 

The Main Menu is organized in the following major processing areas: 

¶ The Menu Bar for system functions 

¶ The Toolbar for system processes  
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Primary Material Planning, Purchasing and Inventory Control 

Functions 

 

The primary Material Planning, Purchasing and Inventory Control functions are the 

following: 

 

WBS Data:  C (Contracts), P (Projects), G (Groups), A (Accounts), Z (Zones), U (Units) 

 

Parts Catalog:  Import or directly enter Direct Purchase, Manufactured Parts, or Stock 

items into the Standard Parts Catalog.  Dbase or Excel files can be imported. 

 

Bills Of Material:  Import or directly enter drawings and related bills of material 

information.  Data can be imported from AutoCAD, AutoPlant, Excel or Maestro. 

 

Requisitions:   Define and maintain project and stock requisitions.  Requisitions may be 

related to work orders. 

 

Pallets:  Material is grouped on pallets to be gathered and issued to meet the 

requirements of  work orders.  Pallets can be defined from either Bills of Material or 

Requisitions. 

 

Purchase Orders:  Define and maintain contract or stock purchase orders.  Contract, 

bulk, blanket and quick purchase orders are allowed. 

 

Invoices:  Enter invoices into the system for transfer to the General Ledger system of 

choice. 

 

Menu Bar Selections 

 

The Menu Bar in each of the modules provides the following supporting functions: 

 

¶ File 

¶ Edit 

¶ View 

¶ Environment 

¶ Library 

¶ Data 

¶ System 

¶ Reports 

¶ Window 

¶ Help 
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FILE  

 

 
 

Figure 1-3:  FILE Menu Functions 

 

FILE (Figure 1-3) provides options to: 

 

¶ New provides user-convenient wizards for starting new contracts and projects.  

Refer to the manual ñGetting Started With PERCEPTION and the chapter 

ñStarting A New Projectò for details. 

¶ Open the PERCEPTION ñOpen Wizardò that allows the user to open any window 

in the system from one place. 

¶ Close the active window. 

¶ Save returns all of the current windowôs information for storage onto the system 

database. 

¶ Save As copies the full contents of the window information to a file.  The user is 

given the option to specify the format for this file: Microsoft Excel, SQL, text, 

etc.  

¶ Save As Web Page copies the full contents of the window information to a file.  

The format of this file is HTML. 

¶ Save Work Space freezes all open windows and their contents so that the user 

may exit the system and later return to these same windows. 

¶ Page Setup specifies which pages to be printed. 

¶ Print Preview displays the contents of the window as it will be printed.  To return 

the window back to its non-preview form, click off the File/Print Preview. 

¶ Printer SetUp specifies the printer selection, print options, etc. 

¶ Print Screen prints only the information visible in the window. 

¶ Print Immediate performs the same function as File/Print except that the user 

has no option for selecting the printer device.  The system chooses the default 

printer available to the user. 
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¶ Print  prints the full  contents of the window information, or as modified by the 

specification of the File/Page Setup.  The user is given the option for selecting the 

printer device, etc. 

¶ Print Bar Code Label creates a bar code label for whatever text is selected. 

¶ Send To allows the user to email windows and reports or send reports to Adobe 

Acrobat to generate a PDF file.  Adobe Acrobat Version 4.0 or greater is needed 

for this capacity to work.  Refer to the manual ñGetting Started With 

PERCEPTION in the chapter ñUsing Email With PERCEPTIONò for additional 

information. 

¶ Properties outlines the operating of the system as installed for the user.  This is 

important information for reporting to SPAR of problems regarding connecting to 

the database and the windows environment. 

¶ Recent allows the user to go directly to the 5-most recent report formats or to the 

5-most recent windows that were is use. 

¶ Exit  from system. 
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EDIT  

 

Edit (Figure 1-4) provides functions that operate on specific data records, which are 

selected and highlighted.  Records can be selected individually by clicking on the left-

most row indicator column, or by choosing Select All from the Edit menu.  If a record 

has been selected, clicking on it again will deselect it.  Most of the functions on the Edit 

menu are also available by clicking on the appropriate button on the toolbar, and by using 

a Ctrl+key combination on the keyboard. 

 

 

Figure 1-4: Edit Menu Functions 

 

¶ Undo reverses the prior edit change. 

¶ Undo Delete negates the prior record delete from the work sheet. 

¶ Repeat duplicates the prior edit . 

 

¶ Cut removes selected record(s) or data to the Windows clipboard. 

¶ Copy copies either selected record(s) or data to the Windows clipboard. 

¶ Paste inserts either data in a column or row(s) from the Windows clipboard. 

¶ Bulk Cut is a special cut process useful for transferring to and from spreadsheets. 

¶ Bulk Copy is a special copy process useful for transferring to and from 

spreadsheets. 

¶ Bulk Paste is a special paste process useful for transferring to and from 

spreadsheets. 

 

¶ Clear Selection deselects the selected row(s). 
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¶ Select All selects and highlights all rows that have been retrieved ï this can also 

be accomplished by clicking on the upper left blank heading box. 

¶ Select Row selects the entire current row and high lights the row. 

¶ Invert Selection will deselect all rows that are selected and select all rows that 

are not selected. 

 

¶ Find searches for a string in a specific column in the rows that have been 

retrieved. 

¶ Replace searches and replaces a string with another string in a specific column in 

the rows that have been retrieved or imported. 

¶ Go To allows the user to specify the row number to which the cursor will move.  

This is useful when the window contains many rows. 

 

¶ Global Defaults allows the user to specify global default values of contract, 

project number, SWBS, PWBS, etc.  These defaults will be used by the system 

when adding new rows into the data window.  They also can be used for 

retrieving new records from the database. 

 

 

Special Edit Functions For Different Environments 

 

The system is organized by basic shipyard department responsibilities.  Each of these 

sections, called ñenvironmentsò is given special sets of editing functions. 

 

For Material Control, the following special edit functions are available from the main 

Edit menu: 

 

¶ Define Pallet generates new pallets 

¶ Global Modifications provides business processes across a range of selected 

documents: authorizing/un-authorizing requisitions for purchasing; 

attach/detach planning activities and work orders from selected requisitions; 

and manually reschedule requisitions (need dates, required in yard dates, etc.). 

¶ Copy Requisitions copies drawing BOMs, requisitions, and pallets 

¶ Receive Non-Purchased Material allows receiving and recording of material 

items not included in the purchase order. 

 

For Purchasing, the following special edit functions are available from the main Edit 

menu: 

 

¶ Create PO Header Text 

¶ Create PO Footer Text 

¶ Generate Draft of Selected PO(s) 

¶ Issue Selected PO(s) 

¶ Print Copy if Selected PO(s) with Bar Code 

¶ Close Selected PO(s) 
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For Stores Management, the following special edit functions are available from the main 

Edit menu when receiving purchased materials: 

 

¶ Back Out Receive Transactions reverses selected receiving transactions 

¶ Post Receive Transactions posts receiving transactions 

¶ Stub Out Purchase Order Receipts copies the items of the purchase order 

into the receiving data window to record receiving information. 

 

For Stores Management, the following special edit functions are available from the main 

Edit menu when returning purchased materials to the vendor: 

 

¶ Back Out Return Transactions reverses selected return transactions 

¶ Post Return Transactions posts return transactions 

¶ Stub Out Purchase Order Returns copies the items of the purchase order 

into the return-to-vendor data window to record what is to be returned. 

 

For Stores Management, the following special edit functions are available from the main 

Edit menu when issuing materials to production: 

 

¶ Stub Out Requisition Withdraws copies requisition items into the 

production issue data window to record what is to be issued. 

¶ Stub Out Pallet Withdraws copies pallet items into the production issue data 

window to record what is to be issued. 

¶ Back Out Selected Transactions reverses selected issue transactions 

¶ Post Selected Transactions posts issue transactions 

¶ Add Stock Parts(s) adds stock parts for issue to production. 

For Stores Management, the following special edit functions are available from the main 

Edit menu when adjusting stock inventory information: 

 

¶ Post Adjust Transactions posts stock adjustment transactions 
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VIEW  

 
 

Figure 1-5:  VIEW Menu Functions 

 

View (Figure 1-5) provides options to quickly move from one application to another to 

access application-specific features, reports, etc.  View also provides various options for 

adjusting visual parameters of the system. 

 

¶ Zoom allows the user to adjust the visual distance between the user and the 

window. 

¶ Restore Column Order restores the default column order of the active worksheet 

window. 

¶ Save Current Column Order saves the current column order for the active 

worksheet window. 

¶ Horizontal Split Scrolling  allows the user to set a second horizontal scroll bar at 

the bottom of the data window. 

¶ Project Navigator enables the user to quickly drill down through projects from 

high-levels to the details.  Project Navigator provides details. 

¶ Set Environment allows the user to easily change environment in which the 

current window will be viewed, i.e., the Estimating view of Project Details may 

be different than the Production Engineering view of the same window.  

¶ Drill Downs  will open a window with the drill down options appropriate to the 

current window available for selection.  Each window has its own set of drill 

down options. 
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ENVIRONMENT  

 
 

Figure 1-6:  Environment Menu Selections 

 

Environment (Figure 1-6) provides direct access to the various basic system applications 

grouped in typical shipyard levels of interest: 

 

¶ Cost Estimating  

¶ Engineering  

¶ Planning & Scheduling  

¶ Production Engineering  

¶ Material Control  

¶ Purchasing  

¶ Stores Management  

¶ Accounting (Time charging & accounting transactions)  

 

Cost Estimating Environment has the following choices: 

 

 
 

Figure 1-7:  Environment/Cost Estimating Menu Selections 

 

¶ Package Library gives full access to the Standard Interim Product Packages 

¶ CER Libraries  gives the user direct access to all types of CERs in the library. 
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¶ Cost Items gives the user direct access to the individual cost items for an 

estimate. 

¶ Rate & Indirect Formula Tables gives the user direct access to project-related 

rates (labor, overhead, profit, etc.) and indirect formulas. 

¶ Escalation gives the user direct access to the material cost escalation table. 

¶ Bulk Copy & Deletes allows bulk copying of projects, portions of a projectôs 

work breakdown structure, CERs, interim product packages, rate tables; and 

global deletions of contracts, projects, and portions of a projectôs work breakdown 

structure.  

¶ Return Costs gives the user access to return costs information. 

¶ Rollup provides the user with options for re-computing data summaries 

throughout the contract/project work breakdown structures.  Specifically, the user 

may perform rollups on cost estimate data. 

¶ Risk Analysis provides a Monte Carlo risk assessment of the cost estimate. 

¶ Transfer Estimate to Production exports cost estimate data directly to the 

Production Engineering and Material Control environments.  Cost Estimate Items 

are gathered into preliminary work orders and material requisitions. 

¶ Reports provides access to all of the reports related to cost estimating. 

¶ Exceptions provides access to all of the special exception reports related to cost 

estimating. 

 

Engineering Environment has the following choices (Figure 1-8): 

 

 
 

Figure 1-8:  Environment/Engineering Menu Selections 

 

¶ Drawings provides access to drawings information. 

¶ Drawing Items provides access to items (bill of materials) of a drawing. 

¶ Search for Part(s) allows the user to search the parts catalog and to view part 

details  

¶ View CAD Drawing allows the user to directly open a DWG file using 

AutoCADôs VoloView software embedded in the system.  Refer to ñViewing 

AutoCAD Drawingsò in the Appendix of the ñGetting Started With 

PERCEPTIONò manual for additional information. 

¶ Reports provides access to all drawing-related reports. 

¶ Exceptions provides access to all drawing-related exception reports. 
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Planning & Scheduling Environment has the following choices (Figure 1-9): 

 

 
 

Figure 1-9:  Environment/Planning & Scheduling Menu Selections 

 

¶ Import MS MPX Schedules allows schedule activities developed in Microsoft 

Project to be imported into the PERCEPTION database. 

¶ Define Build Strategy is not yet available. 

¶ Planning Activities provides direct access to schedule planning activities 

grouped by user-defined ñNetwork Number.ò 

¶ Rollup provides the user with options for re-computing data summaries 

throughout the contract/project work breakdown structures.  Specifically, the user 

may perform rollups on baseline schedule data. 

¶ Manpower provides a manpower analysis based upon planned/actual/forecast 

requirements. 

¶ Reports provides access to all schedule planning-related reports. 

¶ Exceptions provides access to all schedule planning-related exception reports. 

 

 

Production Engineering Environment has the following choices (Figure 1-10) 

 

 
 

Figure 1-10:  Environment/Production Engineering Menu Selections 
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¶ Manpower provides a manpower analysis based upon planned/actual/forecast 

requirements. 

¶ Define Work Orders From Activity  allows project work orders to be developed 

directly under schedule activities. 

¶ Work Orders  opens the work order window for viewing, editing, adding, and 

deleting records. 

¶ Sub Tasks opens the work order sub-task window for viewing, editing, adding, 

and deleting records.  Sub-tasks apply to the special work orders: distributed, 

time-phased and incremental process work orders. 

¶ Pallets opens the material and work order pallet window for viewing, editing, 

adding, and deleting records. 

¶ Bulk Copy Functions allows the user to copy existing projects and/or specific 

levels of the work breakdown structure, including work orders, to a new project. 

¶ Rollup provides the user with options for re-computing data summaries 

throughout the contract/project work breakdown structures.  Specifically, the user 

may perform rollups on actual labor cost and schedule data, including progress 

and final cost forecasts and trends. 

¶ Reports provides access to all labor cost and schedule-related reports. 

¶ Exceptions provides access to all labor cost and schedule -related exception 

reports. 

 

 

Material Control Environment has the following choices (Figure 1-11): 

 

 
 

Figure 1-11:  Environment/Material Control Menu Selections 

 

¶ Requisitions opens the material requisition window for viewing, editing, adding, 

and deleting records. 

¶ Requisitions Items opens the material requisition items window for viewing, 

editing, adding, and deleting records. 

¶ Pallets opens the material and work order pallet window for viewing, editing, 

adding, and deleting records. 
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¶ Pallets Items opens the material and work order pallet items window for viewing, 

editing, adding, and deleting records. 

¶ Bulk Copy Functions allows the user to copy selected projects, portions of work 

breakdown structures, including drawing bills of material, requisitions, and 

pallets. 

¶ Reports provides access to all material control-related reports. 

¶ Exceptions provides access to all material control-related exception reports. 

 

 

Purchasing Environment has the following choices (Figure 1-12): 

 

 
 

Figure 1-12:  Environment/Purchasing Menu Selections 

 

¶ Terms opens the library of standard purchase order terms and conditions for 

viewing, editing, adding, and deleting records. 

¶ Clauses opens the library of standard clauses for purchase order headers and 

footers for viewing, editing, adding, and deleting records. 

¶ Purchase Orders opens the purchase order window for viewing, editing, adding, 

and deleting records. 

¶ Purchase Order Items. 

¶ Reports provides access to all purchasing-related reports. 

¶ Exceptions provides access to all purchasing-related exception reports. 
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Stores Management Environment has the following choices (Figure 1-13): 

 

 
 

Figure 1-13:  Environment/Stores Management Menu Selections 

 

¶ Locations provides access to all defined material storage locations, and to the 

material stored in these locations. 

¶ Storage Items provides access to all the material stored in these locations 

¶ Material Transactions provides access to various stores-oriented material 

processing: 

o Receive Material is the window used to receive material deliveries. 

o Withdraw Material is the window used to issue material to 

production work orders, either by requisition, by pallet, or by Quick 

Stock Withdraw. 

o QA Material  provides access to QA inspection functions for delivered 

material being received. 

o Return Material  provides access to function for formally identifying 

material rejected that is to be sent back to vendor.  

o Stock Adjustments provides access to functions for taking physical 

inventory and initiating adjustments to the database records.  

¶ Reports provides access to all stores-related reports. 

¶ Exceptions provides access to all stores-related exception reports. 
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Accounting Environment has the following choices (Figure 1-14): 

 

 

Figure 1-14:  Environment/Accounting Menu Selections 

 

¶ Project Accounting System Setup defines the general ledger accounts for a new 

project. 

¶ Transfer To Accounting System exports various transactions from 

PERCEPTION for importing into the accounting system General Ledger, Payroll, 

Accounts Payable and Accounts Receivable systems. 

¶ Unpost Accounting Transfers resets transactions on the PERCEPTION database 

to the un-posted status. 

¶ General Ledger Accounts allows the definition of the accounting transaction 

codes. 

¶ Vendor Invoices provides access to the functions for entering vendor invoices for 

the systemôs cross-checking features with purchase orders. 

¶ Customers provides access to customer data window necessary for creating 

customer billing invoices 

¶ Customer Billing provides access to the customer billing data window. 

¶ Rate Tables provides access to the project rate tables (by work center) for 

generating customer billing invoices. 

¶ Transactions allows viewing of all system transactions that can be processed by 

financial and accounting systems. 

¶ Timecards to view, edit, add and delete work order time charges. 
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¶ Labor Types to view, edit, add and delete types of labor charges (regular, over 

time, etc.) 

¶ Employees allows access to view, edit, add or delete employee data for timecard 

processing.  Valid employee entries also are required for buyers to issue purchase 

orders from PERCEPTION. 

¶ Rollup provides the user with options for re-computing data summaries 

throughout the contract/project work breakdown structures.  Specifically, the user 

may perform rollups on actual labor cost and schedule data, including progress 

and final cost forecasts and trends.  Similar roll ups of material costs also can be 

performed. 

¶ Reports provides access to all accounting-related reports. 

¶ Exceptions provides access to all accounting-related exception reports. 
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LIBRARY  

 
 

Figure 1-15:  LIBRARY Menu Functions 

 

LIBRARY (Figure 1-15) provides access to all the modules of MAT-PAC including those 

that are on the Toolbar as well as many that are not.   

 

¶ Company Parameters enables special user options. 

¶ Units of Measure allows the user to define the different units of measure and 

their conversion factors that will be used for, among other things, cost estimating 

CERs and the Parts Catalog. 

¶ Work Centers allows the user to define different areas of work. 

¶ Trades/Resources identifies the shipyard trade categories for budgeting, 

manpower analysis, and performance measurement reporting. 

¶ Vendor Catalog provides an address book for all your vendors. 

¶ Standard Parts Catalog provides a place for compiling a list of commonly used 

parts or normal stock items. 

¶ Currency table enables purchase orders to be issued in foreign currencies.  The 

system will apply exchange rates as defined in this table for domestic currency 

budget performance reporting. 

¶ Calendar sets list of holidays. 

¶ Stages of Construction allows the user to define shipbuilding process by 

sequence. 

¶ Types of Work allows the user to define shipbuilding process by work type. 

¶ Block Types allows the user to define structural interim products made from 

assemblies, sub-assemblies and parts. 

¶ Ship Characteristics is used to record the primary and secondary characteristics 

specific to the ship. 

¶ Ship Types provides a window for retrieving, adding and editing ship types. 
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¶ WBS provides access to the work breakdown structures defined for all projects on 

the database. Refer to the topic ñLinkage and Drill Downsò in the manual, 

ñGetting Started With PERCEPTIONò.. 

¶ WBS History provides access to snap shots of project performance indicators (for 

example, budgets, expended costs, earned values, estimates at completion, etc.) at 

every level of a projectôs WBS. Refer to the topic Linkage and Drill Downs. 

 

Several of the items on the Library menu have a second level.  An arrow pointing to the 

right indicates these.   For example, 

 

Standard Parts Catalog provides access to material type classifications; class attributes 

(physical, material, performance) and to the catalog of parts and interim products 

(assemblies, sub-assemblies, etc.)  

 

 
 

Figure 1-16:  Standard Parts Catalog Menu 

 

Ship Characteristics provides access to the types of characteristics, the characteristics 

library, the list of standard characteristics (for example, LOA, displacement, etc.), and 

groups of characteristics germane to specific ship types.  

 

 
 

Figure 1-17:  Ship Characteristics Menu 

 

¶ Characteristic Types allows the user to identify basic types of characteristics, 

such as operational, hull, cargo, etc. 

¶ Characteristics allows the user to develop a master list of ship design 

characteristics, each cataloged by type. 
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¶ Default Characteristics allows the user to assign selected characteristics from 

the master list as a default set of characteristics when a new project is defined.  

The user then should define the specific values of these characteristics for the 

project. 

¶ Ship Type Characteristics allows the user to develop another list of 

characteristics specific to each ship type.  These characteristics are in addition to 

the default characteristics.  These ship type characteristics also will be loaded 

under a project when a new project is defined with a specific ship type 

designation. 
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DATA  

 
 

Figure 1-18:  Data Menu Options 

 

Data (Figure 1-18) provides options for manipulating data: 

 

¶ Sort opens an option window that contains the column headings of the active data 

window.  The displayed rows of data can be sorted either in ascending or 

descending order by any single designated column.  Any column in a data 

window also can be sorted automatically with a double click on the column 

heading. 

¶ Filter  opens an additional selection window and allows the user to refine a 

selection of data that has been loaded into a worksheet from the database. 

¶ Validate Row selection results in the system validating the data in the current 

row to ensure necessary assignments (work breakdown structure, etc.), have been 

properly defined. 

¶ Validate Selection results in the system validating the data entered in all records 

that have been selected (highlighted) in a worksheet window. 

¶ Validate New/Modified Data will validate every record in the current data set 

that has been added or modified. 

¶ Validate Current Data Set will validate every row in the current data set 

whether it has been modified or not.  This would be valuable for records that have 

been previously created (possibly by using the import or paste function) and saved 

without validating.  

¶ Get External Data imports records that have been created elsewhere. 
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¶ Ditto Records creates an exact copy of one or more selected record(s).  The 

unique key fields will have to be modified before the record can be saved.  This is 

a very fast way to duplicate rows. 

¶ Create Rows quickly creates a specified number of rows.   

¶ Add Record opens a new record at the bottom of the active data window.  If 

global defaults have been set, the new record will automatically have these values.  

If the current window was opened by drilling down from another window, these 

new records will have the key values of its parent. 

¶ Insert Record inserts a new record above the current row.  If global defaults have 

been set, the new record will automatically have these values. If the current 

window was opened by drilling down from another window, these new records 

will have the key values of its parent record.  Other data columns will need to be 

provided manually by the user. 

¶ Delete Records will delete the current row, or multiple rows if more than one is 

selected (highlighted).  These records will be deleted permanently in the database 

only when the user initiates a SAVE operation. 

¶ Retrieve enables the user to retrieve a range of records from the database into the 

active data window. 

¶ Re-Select Rows refreshes the current row, or multiple rows if more than one is 

selected (highlighted) with the data that has been saved on the database. This is 

useful when changes have been made on a record that the user does not wish to 

save, but there are other modifications in the current data set and closing the 

window without saving would lose those other changes.  Another use for this 

feature will apply when a record is changed by another action, or by another user, 

while it was displayed in your session.  Re-selecting this row will reflect the 

changes that have been previously saved. 

¶ Refresh Drop-Downs refreshes the data in a drop-down data window with any 

changes that have been made since the window using the drop-down was opened.  

Refer to Types of Data Fields in Appendix I of ñGetting Started With 

PERCEPTIONò for more information. 

¶ Refresh Linked Windows refreshes the windows in the current linkage chain.  

Refer to Linkage and Drill Downs in ñGetting Started With PERCEPTIONò for 

more information.  

¶ New Query will enable the user to define their own complex arguments for data 

retrieval. 

¶ Data Analysis Extraction Tool provides a statistical data analysis tool. 
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SYSTEM 

 

 
 

Figure 1-19:  System Menu 

 

 

 REPORTS 

 

Figure 1-20:  Reports Menu 

 

Reports (Figure 1-20) provides a variety of different reports that summarize cost data for 

the contract, by separate project SWBS, by PWBS, by BOM, by Cost Item, and by work 

center.  By clicking on the menu, the following pop up menu provides a selection of 

available reports grouped by report category. 

 

 
 

Figure 1-21:  Report Selection Window 
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 WINDOW  

 

 
 

Figure 1-22:  Window Menu Selections 

 

Window (Figure 1-22) allows the user to arrange window positions and other related 

functions.  When multiple data windows are open, the user has the following options for 

arranging them in the workspace: 

 

Cascade is shown in Figure 1-23.  Click on the data window title bar to activate that 

window. 

 

 
 

Figure 1-23:  Cascading Multiple Data Windows 

 

Layer will fi ll the workspace with only the active window (default). 

Tile Vertical arranges the data windows vertically (Figure 1-24). 
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Figure 1-24:  Vertical Tile Arrangement 

 

 

Tile Horizontal arranges the data windows horizontally (Figure 1-25). 

 

 
 

Figure 1-25:  Horizontal Tile Arrangement 

 

The Window menu also allows the user to customize the toolbars.  When clicking on 

Windows/Toolbars, a window appears with various options for the user, Figure 1-26.. The 

user can customize the position, the button size, and whether or not to display the button 
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text of these toolbars.  Throughout the software, the Work Sheet Menu bar (or third 

toolbar) changes depending on which window is open.  This third toolbar provides 

functions that are applicable only to the current window. 

 

 
 

Figure 1-26:  Window/Toolbar Options 

 

 

If more than one window is open, the Window menu also lists them.  The name that is 

preceded by a checkmark is the current active data window.  The user can move to any of 

these windows directly by clicking on the desired one. 

 

 
 

Figure 1-27:  Window Menu Displaying Open Data Windows 



Chapter 1:  Introduction 

 

This document contains intellectual properties copyrighted by SPAR Associates, Inc.Page 28 

 

 

HELP 

 
 

Figure 1-28:  Help Menu Options 

 

Help (Figure 1-28) provides various user on-line aids, including the contents of the 

manuals by chapters; index of key words; and the answer wizard that provides a search 

function for user-specified question.  

 

¶ Help Contents gives access to all PERCEPTION user manuals. 

¶ Welcome To PERCEPTION 7.0 gives access to the ñGetting Started with 

PERCEPTIONò user manual.  This manual provides basic ñHow Toò instructions 

for navigating the PERCEPTION system and performing the basic functions for 

data entry, database retrieval, and reporting. 

¶ Help On Topics provides access to the user manuals that have been broken out 

by subject matter. 

¶ About PERCEPTION 7.0 displays the current version of the software. 
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TOOLBAR  

 

 
 

Figure 1-29:  Toolbar Functions 

 

Many of the supporting functions that are in the main menu system can be executed with 

a single click on a button on the toolbar.  Many of these functions are standard Windows 

functions.  The user can customize the position, the button size, and whether or not to 

display the button text of these toolbars. By right clicking on a toolbar, the changes will 

be made to that toolbar.  The second toolbar is only visible while in one of the modules, 

and several of the buttons on this toolbar are only active when an appropriate action has 

been taken to make them active.  There is also a third toolbar that is window specific.  It 

provides functions that are exclusive to the active window. 

 

The first toolbar provides direct access to define, view, or modify the following: 

 

  Project Navigator opens the tree view navigation through the projects. 

 

  Environment Selector allows the user to easily change environment in which the 

current window will be viewed, i.e., the Estimating view of Project Details may be 

different than the Production Engineering view of the same window. 

  Global Defaults allows the user to enter default values that the system will use for 

entry of new records and for the range retrieval selection windows.  

 

  opens either the WBS Contract, Project, Group, Account, Zone, 

or Unit windows. 

 

  Parts Catalog opens the window to view or enter standard parts. 

  Run Reports opens the report selector window. 

  Help loads the user manual. 

  Exit  ends the session. 
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The second toolbar provides the following: 

 

  Close the active window workspace. 

  Print  the data as displayed. 

  Save changes to all records in the active window workspace. 

  Cut removes selected record(s) or data to the Windows clipboard. 

  Copy copies either selected record(s) or data to the Windows clipboard. 

  Paste inserts either data in a column or row(s) from the Windows clipboard. 

  Select All selects and highlights all of the rows that have been retrieved ï this can 

also be accomplished by clicking on the upper left blank heading box. 

 

  Delete will delete selected records. 

  Add allows the user to add a new record. 

  Retrieve provides the option to view a different set of records. 

  Reselect Rows will re-retrieve the selected records to reflect the data as it is 

currently saved on the database. 

 

  Find searches for a string in a specific column in the rows which have been 

retrieved. 

 

  Replace searches and replaces a string with another string in a specific column in 

the rows that have been retrieved or imported. 

 

NOTE:  Care should be exercised when using replace.  Replace is intended for a situation 

where new records have been imported and a global change is required in these records.  

The error checking that takes place after a replace is not as complete as when new data is 

typed into a column. 

 

  Sort opens an option window that contains the column headings.  The displayed 

data can be sorted either in ascending or descending order by any single or multiple 

columns. 

  Filter  opens an option window that allows the user to further fine-tune the selection 

of rows displayed. 

 

NOTE:  See General System Operation for further discussion of filter functionality. 

 

Validate will check the data for the entire dataset in the window that is active. 

  Run Associated Reports 
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  Mail  will create an Excel file of the complete dataset in the window that is active and 

attach it to an email that can be sent to anyone in the userôs email address book. 

 

  PDF Writer  will create an Adobe Acrobat PDF file containing the data in the 

current data set.  The Adobe Acrobat software must be properly installed.  Adobe 

Acrobat Version 4.0 or greater is needed for this capacity to work.  The PDF Distiller that 

is installed and the path to the PDF ini file must be entered in the company defaults table.  

To do this, select Library/Company Defaults from the main menu. 

 

  Drill Downs  opens a window with the drill down options appropriate to the current 

window available for selection. 

 

The following buttons are available only when the free-form data windows are open: 

 

  First  moves to the first record of selection. 

  Prior  moves to the previous record of selection. 

  Next moves to the next record of selection. 

  Last moves to the last record of selection. 
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General System Operation 

 

Generally, all data entry windows (tables, forms, etc.) allow the user to add, change, cut, 

copy, paste, sort, filter and delete information using the same procedures.  The following 

describes these fundamental procedures for operating the system. 

 

Data Windows 

 

Data windows are the various displays of information by the system.  Data windows are 

used to enter data, to process data, to view data, and to generate reports. 

 

Opening Data Windows 

 

Data windows are displayed in the workspace.  The various menu options provide the 

user with direct access to the data windows desired.  Clicking on the menu selection will 

cause the system to open that window into the workspace. 

 

However, once a data window has been opened, additional data windows are generally 

available, typically for details, lower level information and related data windows.  These 

lower level windows can be accessed by clicking on the Drill Down button  on the 

toolbar, or by clicking the right mouse button.  This causes a sub-menu to appear listing 

these lower level and related windows for the user.  Drag the cursor down the sub-menu 

and select the desired menu item. 

 

Closing Data Windows 

 

Data windows can be closed simply by clicking on the X icon, either in the upper right 

corner of the data window or the X button  on the toolbar.  If information in the data 

window has been altered in any way, the system will always ask the user if the changes 

should be saved onto the database before closing. 

 

Opening Multiple Data Windows 

 

The system allows any number of data windows to be open at any time.  Any of these 

windows can be activated by clicking anywhere inside that window or by clicking on its 

title bar, which when made active becomes highlighted.  The other open data windows 

will have title bars that are not highlighted. 

 

Multiple data windows can be displayed differently at the option of the user 
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Worksheet DataWindows 

 

Many of the data windows of the system are worksheets (Figure 1-30) that list multiple 

rows of records.  This type of data window looks like a spreadsheet and is a convenient 

means for the user to visually see a range of records and their information. 

 

 
 

Figure 1-30:  Sample Worksheet Window 

 

Detail Data Windows 

 

Rows of records in any given data window usually have details that are not easily 

displayed on the worksheet window.  A double click (left mouse button) on a row will 

bring up a detail data entry window presentation of the rowôs data (Figure 1-31).  

Alternative methods for opening a detail data window are to highlight the record row by 

giving it a single click, then clicking on the Drill Down button  on the toolbar, or by 

right clicking with the mouse on the record to open the pop up sub-menu that provides 

Detail as one of its selections. 
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Figure 1-31:  Sample Detail Data Window 

 

When a detail data window is open, the scroll buttons on the toolbar (First, Prior, Next, 

Last)  will move through all the records that are on the worksheet 

window that is behind the detail window.   

 

Note also that if you click on the Print  button on the toolbar when a detail window is 

open, or select File/Print from the main menu, the system will print all of the records that 

are on the worksheet window, not just the record in the detail window that is currently 

visible. 

 

Tab Style Data Windows 

 

Some of the information on the database can be more conveniently presented to the user 

in what is called a tab data window. Figure 1-31, the Sample Detail Data Window also 

has a tab data window.  The controlling data window is a worksheet window.  But after 

highlighting a particular record in the worksheet window, the user can then click on the 

different tabs to open different detail windows for that record. 
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Database Processing 

 

When dealing with records on the database (WBS, cost items, rate tables, etc.), data entry 

windows provide options for adding new records, updating existing records, and deleting 

unwanted records.  The following are general rules for performing these different 

transactions. 

 

First, open the desired data entry window from a selection menu or the toolbar.  Most 

data entry windows initially open with no information displayed.  The user is required to 

either retrieve desired information from the database or begin adding new information 

directly. 

 

Retrieving Database Records 

 

To retrieve existing records into the data entry window, click on the Retrieve button  

on the toolbar or select Retrieve from the Data menu.  The system will provide an 

opportunity for the user to narrow this retrieval operation to only the selection that the 

user specifies.  The Parts Catalog retrieval window (Figure 1-32) is an example.   

 

The record retrieval selection process is one whereby the user can specify a range  

(minimum and maximum) of values for a particular set of information.  The user may use 

any or all of the criteria available on the selection window to narrow the search and 

retrieval process.   

 

Most data fields that identify various records (for example, part number, work order 

number, purchase order number, etc.) are alphanumeric, even if the user has set up 

numeric identifiers; the system still treats these identifiers as alphanumeric.  The systemôs 

sorting order for characters is as follows: 

 

0123456789ABCDEFGHIJKLMNOPQRSTUVWXYZ.  Small letters and capital letters 

are treated equally. 

 

The lowest possible value for an identifier is the numeric character zero (ñ0ò) and the 

highest possible value for an identifier is the maximum length of characters for the 

identifier filled with the character ñZò. If the default values of 0 and ZZZZZZZZ are left 

unchanged for any field(s) on the retrieval window, then the system will not use that field 

when building the query from the database.  For example, on the figure below, if the Part 

ID range is changed to 101200 to 101300, and the Asset Account range is not changed 

from the default of 0 ï ZZZZZZZZ, then all records with a  Part ID between 101200 and 

101300 will be retrieved regardless of what Asset Account the part is assigned to. 
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Figure 1-32:  Parts Catalog Retrieval Window 

 

Adding New Database Records 

 

To add new records, the user must click on the Add button  on the toolbar or the Add 

Record or Insert Record options from the Data menu. 

 

More records can be added by clicking Add each time; however, using the keyboard 

down-arrow key also will open a new record for data entry.  

 

Modifying Database Records 

 

Moving from one field to another can be done by with the mouse or the tab key.  Then, 

the user must click on the Save button  to make these changes permanent on the 

database.  The user also can Close the data screen window without clicking on the Save 

button, and the system will respond by instructing the user that changes have been made 

to the record and that the user can either save or discard them. 

 

Additional details are given below for a variety of data editing features. 

 

Selecting Multiple Records 

 

On the worksheet windows, multiple rows can be selected.  There are two methods for 

highlighting multiple records (i.e., rows of data).   

 

For a series of records that are together row-wise, hold down the keyboard Shift key and 

a click at the top-most record to select.  Keep holding the Shift key down and move the 

cursor down to the lowest record to select and click on it.  All rows in this series will then 

become highlighted, or selected. 

 

For rows that are not all together in a series, but are interspersed in various rows, hold 

down the keyboard Ctrl key and then click on each row to be selected. 
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Deleting Database Records 

 

Generally, there are two types of data entry screens that have slightly different methods 

for deleting records.  For screens that display only a single record (most detail windows), 

a click on the Delete button  or selecting Data/Delete Records from the main menu 

will command the system to delete just that record which is on display.   

 

On the worksheet windows, multiple records can be deleted at one time by selecting the 

rows to be deleted and then clicking on the Delete button. 

 

Saving Database Records 

 

When finished adding, changing and/or deleting database records, click on the Save 

button  on the toolbar to write the changes to the database.  This Save transaction will 

also permanently delete any records that have been deleted in the data window.  The 

system will then inform the user if the update is successful.   

 

The user also can Close the data window (X button) without clicking on the Save button, 

and the system will prompt the user to either save the changes or discard them. 

 

If, for some reason, the program aborts before the Save button has been clicked, the 

current changes will not be saved on the database and must be re-entered. 

 

Printing Database Records 

 

To print a copy of the window as displayed, select Print Screen from the File menu.  

Clicking on the Print button  on the toolbar will print all of the data that is displayed 

in the current data set. 

 

Sorting Records 

 

Data displayed in any worksheet can be sorted by any column of information.  Click on 

the column header and the rows of data will be sorted immediately in ascending order of 

the contents of that column.  A second click and the rows will be sorted in descending 

order 
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Global Defaults 

 

Oftentimes, when making multiple entries of new records, certain data (for example, 

project number) are repeated entry after entry.  In order to have the system make these 

specific data field entries automatically, click on Global Defaults  button on the 

Toolbar.  The system will present a Global Defaults window for the user to fill in as 

necessary (Figure 1-33).  Thereafter, when a new record is added, the system will 

automatically insert the values of these defaults into the appropriate data fields. Global 

defaults will not apply to any existing records. 

 

Also, when retrieving records into a data window, the user has the option to use these 

global defaults for the retrieval argument. 

 

 
 

Figure 1-33:  Setting Global Defaults 

 

Once global defaults have been set (by clicking on the OK button), they will be saved by 

the system into the userôs personal registry.  The next time the default window is opened, 

the saved values will be presented and can be used in the current session by clicking on 

the OK button.  The defaults can be removed from the registry by clicking on the Clear 

button.  Values on the window, that have not yet been saved, can be removed from the 

window by clicking on the Reset button. 
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Rearranging Columns on the Screen 

 

Columns in a worksheet window can be arranged in any order you wish for ease of data 

entry.   

 

In general, you may want to move empty columns to the right, or conversely, you may 

want to move full columns to the left.  

 

To rearrange the columns, point at the top of a column (the gray heading box) that is to 

be moved and depress the left mouse button, holding it down.  The entire column of data 

will be highlighted and a vertical bar will appear.  The column can then be dragged (keep 

the mouse button depressed) either to the right or to the left.  When the edge of the screen 

is reached, it doesnôt appear that the column can be dragged any farther.  At this point, 

release the mouse button, and this will temporarily insert the column at that point.  Then 

use the horizontal scroll bar to shift the display further, so that moving the column can be 

resumed.  Return to the column being moved, click on it and keep the button depressed 

and continue dragging the column to the desired location. 

 

When the columns are rearranged, the new column order can be saved so that they will be 

displayed this way the next time this window is opened, either in the current session, or 

future sessions.  Do this by selecting View/Save Current Column Order from the main 

menu.  To restore the column order to the original default order, select View/Restore 

Column Order.
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Chapter 2:  Sample Contract 
 

 

The upper levels of the sample Contract have been defined for this tutorial.  They can be 

viewed by clicking on the C, P, G, A, Z, or U buttons on the Toolbar.  Retrieve the 

appropriate data by clicking on the Retrieve button.  They are as follows: 

¶ Contract   - A-DEMO 

¶ Project    - 01, Buoy Tender - Hull 1 

¶ SWBS Group - 2, Propulsion Plant 

¶ SWBS Account - 262, Main Propulsion Lube Oil System 

¶ PWBS Zone - 20, Engine Room 

¶ PWBS Units - 709P, ENG RM BHD, Port 

- 709S, ENG RM BHD, Starboard 

 

The Contract (C on the toolbar), A-DEMO  is in the database.  You will add your own 

project to the contract A-DEMO .  Click on P on the toolbar.  The Projects window will 

open.  Click Retrieve on the toolbar.  The Retrieval screen shown in Figure 2-1 will be 

displayed.   

 

 
 

Figure 2-1:  Project Retrieval Window 

 

Select the Contract A-DEMO  in each of the Contract drop-down windows to select only 

this contract.  Click OK and any projects defined for this contract will be displayed.  You 

will define a new project.  The first project for the demo is 01.  You will define 02, if this 

has already been defined, you will define 03, and so on. 
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Click Add on the toolbar.  A new row will be displayed, Figure 2-2.  Select the contract 

(A-DEMO ); enter the project (02 or the next in sequence), and the description.  Click the 

Save button on the toolbar to save the record. 

 

 
 

Figure 2-2:  Projects Worksheet Window 

 

The remaining upper levels must now be defined.  They can be identical regardless of the 

project.  To define the Group, Account, Zone or Unit, select the project by clicking on it 

with the left mouse button, and right click on it.  A pop up menu will appear, select Drill 

Downs, Figure 2-3, and the Select Drill Down window appears.  The Select Drill Down 

window can also be opened by selecting the project and clicking on the Drill Down icon 

 on the Toolbar  
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Figure 2-3:  Projects Pop up Menu 

 

When the Select Drill Down window appears, select SWBS Groups to open the SWBS 

window.  Click on the Add button to add a new SWBS Group.  Note that the Contract and 

the Project are automatically filled from the level above.  Type 2 in the Group field and 

Propulsion Plant in the description field.   Click on Save on the Toolbar to save the 

record.   

 

From the Group window, drill down to SWBS Accounts.  When the SWBS Account 

window appears, click Add on the toolbar.  Note that at this level, the Contract, the 

Project, and the Group are automatically filled from the level above.  Type 262 and Main 

Propulsion Lube Oil System into the appropriate fields.  Click on the Windows X and 

save the record.   

 

Click on the Windows X once again on the Group window to return to the Project 

window.  You will now add the PWBS Zone and Unit in the same manner as the Group 

and Account were added above.  Drill down to PWBS Zones.  When the Zone window 

appears, click Add on the toolbar and add Zone 20, Engine Room.  Click on Save on the 

Toolbar to save the record.   

 

From the Zone window, drill down to PWBS Units.  When the Unit window appears, 

click Add on the toolbar and add Units 709P, Eng Rm Bhd, Port and 709S, Eng Rm 

Bhd, Starboard. Click on the Windows X and save the records.   

 

The upper levels can be viewed at any time by clicking on the C, P, G, A, Z, or U buttons 

on the Toolbar.  Retrieve the appropriate data by clicking on the Retrieve button.  You 

have only added the PWBS Zones and Units for the purpose of this tutorial.  However, 

several other levels of PWBS, and Cost Accounts, are available for definition as well. 
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In the following main menu items, information has been added to the database for use in 

this tutorial.  These items can be viewed by selecting the path from the main menu or 

clicking the Retrieve button  on the toolbar. 

 

Library/Standard Part Catalog/Classifications 

(none) default classification 

BOLT 

FLANGE 

VALVE  

 

Library/Standard Part Catalog/Catalog 

 SPN-PVBFLY/150-24 

 SPN-PVCHK/150-20 

 SPN-PVBFLY/150-20 

 PN-PVRSELF-8X10 

 SPN-PVGATA/150-20 

SPN-PVGATA/15024 

 

Environment/Purchasing/Terms 

 Demo 30  

 

Library/Currency  

 US $ 

 

Library/Vendor Catalog  

 vendor A 

 vendor name A Demo 

 

Environment/Stores Management/Locations 

 Demo 

 

Environment/Purchasing/Clauses 

 Demo 

 

Library/Work Centers  

 0   -   Spar Center 

 

The work order Demo must be defined for your project number and will be used for 

this tutorial for the creation of a requisition and a pallet.  To define this work order for 

your project, select Environment/Production Engineering/Work Orders on the main menu 

bar.  Click on the Add Record  icon on the toolbar to get a new line for data entry.  

Select A Demo from the contract drop-down box; type in your project number;  select 

work center 0; type in Demo for the work order and Tutorial  for the description (Figure 

2-4). Click on the Save  button and close the window 
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Figure 2-4:  Demo Work Order 
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Chapter 3:  Drawings / Bills Of Materials 
 

 

Using the WBS levels created for this project, we will now create a drawing.  The 

drawingôs associated bills of material will be created by using parts from the Parts 

Catalog and by adding non-stock/non-standard parts. 

 

To create a new drawing, select the Environment/Engineering/Drawings from the main 

menu, Figure 3-1. 

 

 
 

Figure 3-1:  Bill of Material Module Icon 

 

Click the Add button  on the Toolbar.  Double click on the new line and a Detail 

window with a Drawing tab and a Drawing Items tab will open (Figure 3-2).  The first tab 

provides general information about the drawing (referred to as a header record). 

 

 
 

Figure 3-2:  Drawing Tab Window 


















































































